
Getting to Know
Adobe Acrobat 

If, after perusing your local bookstore, you decided to lay down
your money at the counter, carry away this ten-pound volume, and

take it to bed with you tonight, you probably already know something
about Adobe Acrobat. Why else would you buy this book? If you’re at
the bookstore shelf and you haven’t bought it yet, then you’re proba-
bly wondering how in the world anyone could write so many pages
for such a simple application.

What Is Adobe Acrobat?
Assuming you know little about Adobe Acrobat, I start with a brief
description of what Acrobat is and what it is not. As I explain to 
people who ask about the product, I usually define it as the most mis-
understood application available today. Most of us are familiar with
the Adobe Reader software, which is a product from Adobe Systems
Incorporated that you can download free from the Adobe Web site
(www.adobe.com/acrobat). You can also acquire the Adobe Reader
from all the installation CD-ROMs for other Adobe software. You can
even acquire Adobe Reader from other users, as long as the Adobe
licensing requirements are distributed with the installer program.
The Adobe Reader, however, is not Adobe Acrobat. Adobe Reader is
a component of a much larger product that has evolved through sev-
eral iterations over more than a decade.

You’re probably a little more sophisticated and realize there is a major
difference between the applications noted previously and you may
wonder why I even spend any time discussing the difference between
Acrobat and Adobe Reader. Interestingly enough, I attended a PDF con-
ference not too long ago. The conference coincided with a worldwide
technology conference and one of the speakers at the PDF conference
took a video camera and microphone to the other conference and
interviewed random attendees, asking questions like, “What is Adobe
Acrobat?” and “What is PDF?” Surprisingly, most of the computer-savvy
interviewees could not provide a correct answer. Inasmuch as Acrobat
has come a long way, many people still confuse what you purchase
from Adobe Systems and what you can download free.

To add a little more confusion, this iteration of Acrobat includes the
three different kinds of viewer applications found in the last release
and many new features added to the Adobe Reader software. Adobe
Reader software remains a free download from Adobe’s Web site. 
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4 Part I ✦ Welcome to Adobe Acrobat

The other two Acrobat viewers are software products you need to purchase from Adobe
Systems or from software vendors. They include Adobe Acrobat Standard and Adobe Acrobat
Professional. As I talk about Adobe Acrobat in this chapter, I’m referring to both Acrobat
Standard and Acrobat Professional.

There are distinctions between the Acrobat Standard product and the Acrobat Professional
product in terms of tools and commands. Most editing tasks can be handled in either viewer;
however, Acrobat Professional does provide more editing features than Acrobat Standard.
Throughout this book I delineate the differences and point out when an Acrobat Professional
feature cannot be accomplished in Acrobat Standard.

Adobe Acrobat (either Standard or Professional) in version 7 is the upgrade from Adobe
Acrobat 6 (Standard or Professional) and both viewers are the subject of the remaining chap-
ters of this book. Acrobat is the authoring application that provides you tools and commands
for a host of features outlined in the following chapters. If you haven’t yet purchased a copy
of Acrobat, either the Standard version or the Professional version, you might want to look
over Chapter 2 and observe some of the comparisons between the viewers. If fewer tools and
features suit your purpose, you might find the Standard version satisfactory. Although some
of the features differ between the viewers, they both provide many features for editing,
enhancing, printing, and working with PDF documents.

Acrobat is an authoring application but it has one little feature that distinguishes it from
almost any other authoring program. Rather than starting from scratch and creating a new
document in Acrobat, your workflow usually involves converting a document, created in just
about any program, to a Portable Document Format (PDF) file. Once converted to PDF you
use Acrobat to edit and refine the document, add bells and whistles and interactivity, or pre-
pare it for professional printing. In addition to the Acrobat program, Acrobat Professional
ships with companion programs such as Adobe Acrobat Distiller and Adobe Acrobat Catalog,
and Adobe Designer (Windows only). Acrobat Standard ships only with Acrobat Distiller.
These companion products are used to convert PostScript files to PDF, create search indexes,
and author XML-based forms.

For information related to Acrobat Distiller see Chapter 8. For more information on Acrobat
Catalog, see Chapter 5. For more information related to Designer, see Chapter 26.

Acrobat solutions are greatly extended with other supporting programs from Adobe Systems
and many different third-party vendors. If Acrobat can’t do the job, chances are you can find
a plug-in or companion program to handle all you want to do with a PDF file.

For information related to Acrobat plug-ins and companion products see Chapter 2.

What Is PDF?
PDF, short for Portable Document Format, was developed by Adobe Systems as a unique for-
mat to be viewed through Acrobat viewers. As the name implies, it is portable, which means
the file you create on one computer can be viewed with an Acrobat viewer on other comput-
ers, handheld devices and on other platforms. For example, you can create a page layout on a
Macintosh computer and convert it to a PDF file. After the conversion, this PDF document can
be viewed on a UNIX or Windows machine. 
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5Chapter 1 ✦ Getting to Know Adobe Acrobat

Multiplatform compliance (to enable the exchange of files across different computers, for
example) is one of the great values of PDF documents.

So what’s special about PDF and its multiplatform compliance? It’s not so much an issue of
viewing a page on one computer created from another computer that is impressive about
PDF. After all, such popular programs as Microsoft Excel, Microsoft Word, Adobe Photoshop,
Adobe InDesign, Adobe FrameMaker, and Adobe Illustrator all have counterparts for multi-
platform usage. You can create a layout on one computer system and view the file on another
system with the same software installed. For example, if you have Adobe InDesign installed
on a Macintosh computer and you create an InDesign document, that same file can be viewed
on a PC with InDesign running under Windows.

In a perfect world, you may think the capability to view documents across platforms is not so
special. Document viewing, however, is secondary to document integrity. The preservation of
the contents of a page is what makes the PDF so extraordinary. To illustrate, suppose you
have an InDesign document created in Windows using fonts generic to Windows applications.
After it’s converted to PDF, the document, complete with graphics and fonts intact, can be
displayed and printed on other computer platforms. And the other computer platforms don’t
need the fonts or graphics to print the file with complete integrity.

This level of document integrity can come in handy in business environments, where soft-
ware purchases often reach quantum costs. PDF documents eliminate the need to install all
applications used within a particular company on all the computers in that company. For
example, art department employees can use a layout application to create display ads and
then convert them to PDF so that other departments can use the free Adobe Reader software
to view and print those ads for approval.

The benefits of PDF viewing were initially recognized by workgroups in local office environ-
ments for electronic paper exchanges. Today users have much more opportunity for global
exchange of documents in many different ways. As you look at Acrobat and discover some of
the features available for document comment and markup, comparing documents, support
for layered files (which adds much more functionality to Adobe Reader), and preparing PDFs
for screen readers, you’ll see how Acrobat and the PDF have evolved with new technologies.

The term screen reader is used extensively throughout this book. When you see a reference
to “screen reader,” I’m referring to either a hardware device or special software (JAWS,
Kurzweil, and so on) used to convert visual information to audio format. For more informa-
tion on screen readers and making documents accessible to the readers, see Chapter 20.

Document repurposing
The evolution of the computer world has left extraordinary volumes of data that were originally
designed to be printed on paper on computer systems. Going all the way back to UNIVAC, the
number crunching was handled by the computer and the expression was the printed piece.
Today, forms of expression have evolved to many different media. No longer do people want
to confine themselves to printed material. Now, in addition to publishing information on
paper, we use CD-ROMs, the Internet, and file exchanges between computers. Sometimes we
use motion video, television, and satellite broadcasts. As high-speed access evolves, we’ll see
much larger bandwidths, so real-time communication will eventually become commonplace.
And the world of tomorrow will introduce more communication media. Think of outputting to
plasma, crystal, and holograms, and then think about having a font display or link problem
with one of those systems!
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6 Part I ✦ Welcome to Adobe Acrobat

Technology will advance, bringing many improvements to bandwidth, performance, and
speed. To enable the public to access the mountains of digital data held on computer systems
in a true information superhighway world, files will need to be converted to a common for-
mat. A common file format would also enable new documents to be more easily repurposed,
to exploit the many forms of communication that we use today and expect to use tomorrow.

Acrobat Professional has added more tools for helping users repurpose documents. Tools for
repairing problem files, downsizing file sizes, porting files to a range of different devices, and
eliminating unnecessary data are part of the many features found in Acrobat Professional. In
addition, the new PDF/A format available in Acrobat 7 is designed specifically for archiving
documents. A standards committee has developed this format so documents viewed on com-
puter systems 100 years from now will be compatible with future operating systems.

PDF and Adobe PostScript
The de facto standard of almost all printing in the graphics industry is Adobe PostScript.
Ninety-nine percent of North America and about seventy-five percent of the rest of the world
uses PostScript for all high-end output. Adobe developed this page description language to
accurately display the design created on your computer screen to the printed page. If graphics
and fonts are included in your files and you want to print the pages to high-end professional
devices, then PostScript is the only show in town. The Adobe PostScript language was
responsible for the rise of so many software and hardware manufacturers. If you stop and
think about it, PostScript ranks up there with MS-DOS and Windows in terms of its installed
user base.

Okay, so how does PostScript relate to PDF? In the initial release of Acrobat, all PDF conversion
began with a file that was created as a PostScript file. Users selected the Print command in an
authoring program and printed the file to disk — thus creating a PostScript file. This file was
then opened in the Acrobat Distiller program and Distiller converted the PostScript to a PDF.

Distiller is still a part of Acrobat. In some cases, creating a PDF from a PostScript file rather
than through any of the many other means available may be preferable. It could be that you
have a problem with exporting to PDF from a program, such as fonts not appearing embed-
ded, or you may need to create a PDF for a special purpose like printing and prepress. In such
circumstances using Acrobat Distiller may be your best solution for generating a PDF docu-
ment to properly suit the purpose.

For information related to printing PostScript files and using Acrobat Distiller see Chapter 8.

Printing to PostScript and opening PostScript files in Distiller is used much less today
because now so many programs support PDF creation through one-button clicks or using the
Save As command. However, many of these one-button clicks still use the Distiller application
in the background to create the PDF file. You may not see Distiller launched when PDFs are
created in the background, but the program is working away to convert your authoring appli-
cation document to a PDF file. 

PostScript can be a problem solver for you, and you may have an occasional need to use
it even if your workflow does not require its use all the time. The more you know about
PostScript and Acrobat Distiller, the more often you might be able to rescue problem files
that don’t seem to properly convert to PDF.
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7Chapter 1 ✦ Getting to Know Adobe Acrobat

PDF versions
Acrobat is now in version 7. The version number indicates the number of releases of the
product. PDF is a file format and with it you’ll also find a version number. The PDF version
relates to the specifications of the file format; for the end user it’s usually not so important to
understand all the specifications as much as it is to know what it does for you or what you
can expect from it. If you create PDF documents for users of older Acrobat viewers and use
the newer PDF format, your users may not be able to view your PDF files. Conversely, creating
PDF files with the older version might prohibit you from using some newer features in the
recent release.

With PDF file conversion you have choices for creating and saving PDF documents with your
choice of version number. Depending on which version you select you’ll have different speci-
fications assigned to the file. To give you an idea for how PDF format has changed, look over
Table 1-1.

Table 1-1: PDF Version Compatibility Differences

Acrobat 3.0 Acrobat 4.0 Acrobat 5.0 Acrobat Acrobat 
Professional 6.0 Professional 7.0

Supports PDF Supports PDF Supports PDF Supports PDF Supports PDF 
version 1.2. version 1.3. version 1.4. version 1.5. version 1.6.

PDF files can PDF files can PDF files can PDF files can PDF files can  
be opened by be opened by be opened by be opened by be opened by 
Acrobat viewers Acrobat viewers Acrobat viewers Acrobat viewers Acrobat viewers
3.0 and later. 3.0 and later. 3.0 and later. 3.0 and later. 3.0 and later.

Minor viewing Some viewing Some viewing Some viewing 
problems with problems with problems with problems with 
earlier viewers may earlier viewers may earlier viewers may earlier viewers may 
be experienced. be experienced. be experienced. be experienced.

Page size is Page size is Page size is Page size is Page size is 
limited to available up to available up to available up to available up to 
45 inches × 200 inches × 200 inches × 200 inches × 200 inches ×
45 inches. 200 inches. 200 inches. 200 inches. 200 inches.

Document Document length Document length Document length Document length 
conversion is is limited only by is limited only by is limited only by is limited only by 
limited to RAM and hard RAM and hard RAM and hard RAM and hard 
32,768 pages. drive space. drive space. drive space. drive space.

Color conversion Color conversion Color conversion Color conversion Color conversion 
supports CalRGB. supports sRGB. supports sRGB. supports sRGB. supports sRGB,

supports color
conversion of 
RGB to CMYK.

ICC Profile ICC Profile ICC Profile ICC Profile ICC Profile 
embedding embedding embedding embedding embedding 
supported. supported. supported. supported. supported.

Continued
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8 Part I ✦ Welcome to Adobe Acrobat

Table 1-1 (continued)

Acrobat 3.0 Acrobat 4.0 Acrobat 5.0 Acrobat Acrobat 
Professional 6.0 Professional 7.0

DeviceN color DeviceN color DeviceN color DeviceN color DeviceN color 
space is converted space is supported. space is supported. space with 32 space with 32 
to an alternate colorants is colorants is 
color space. supported. supported.

Smooth shading Smooth shading Smooth shading Smooth shading Smooth shading 
is converted is supported. is supported. is supported. is supported.
to images.

Patterns display Patterns display Patterns display Patterns display Patterns display 
at 50 percent accurately and accurately and accurately and accurately and 
but print correctly. print correctly. print correctly. print correctly. print correctly.

Places halftone Will place halftone Will place halftone Will place halftone Will place halftone 
information in information only information only information only information only 
the PDF. when the Preserve when the Preserve when the Preserve when the Preserve 

Halftone information Halftone information Halftone information Halftone information
is selected in the is selected in the is selected in the is selected in the 
Color Job Options. Color Job Options. Color Job Options. Color Job Options.

Preserve, remove, Preserve and Preserve, remove, Preserve, remove, Preserve, remove, 
and apply Transfer remove Transfer and apply Transfer and apply Transfer and apply Transfer 
functions are functions are functions are functions are functions are 
supported. supported but supported. supported. supported.

NOT apply Transfer 
functions. 

Masks do not Masks are sup- Masks are sup- Masks are sup- Masks are sup- 
display or print ported in viewing ported in viewing ported in viewing ported in viewing 
properly. and printing. and printing. and printing. and printing.

Photoshop 6.0 Photoshop 6.0 Photoshop 6.0 Photoshop 6.0 Photoshop 6.0 and 
layers and trans- layers and trans- layers and trans- layers and trans- above layers
parency are not parency are not parency are parency are and transparency 
supported. supported. supported in  supported in  supported in 

Save as PDF from Save as PDF from Saves as PDF from 
Photoshop only. Photoshop only. Photoshop only.

Illustrator 9.0 Illustrator 9.0 Illustrator 9.0 Illustrator 9.0 Illustrator 9.0 and 
transparency is transparency is transparency is transparency is above transparency 
supported. supported. supported in supported in supported in Save 

Save as PDF from Save as PDF from as PDF from 
Illustrator only. Illustrator only. Illustrator only.

Cannot embed Can embed Can embed Can embed Can embed 
double-byte fonts. double-byte fonts. double-byte fonts. double-byte fonts. double-byte fonts.

TrueType fonts TrueType fonts TrueType fonts TrueType fonts TrueType fonts 
cannot be can be searched. can be searched. can be searched. can be searched.
searched.
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9Chapter 1 ✦ Getting to Know Adobe Acrobat

Acrobat 3.0 Acrobat 4.0 Acrobat 5.0 Acrobat Acrobat 
Professional 6.0 Professional 7.0

Supports 40-bit Supports 40-bit Supports 40-bit Supports 40-bit Supports 40-bit, 
encryption. encryption. encryption and encryption and 128-bit, and 

128-bit encryption. 128-bit encryption. 256-bit encryption.

No PDF/X support. No PDF/X support. No PDF/X support. PDF X/1-A and PDF X/1-A, 
No PDF/A support. No PDF/A support. No PDF/A support. PDF X/3 are PDF/X1-A 2003, 

supported. PDF X/3, PDF/X3 
No PDF/A support. 2003, PDF/A are

supported.

No Adobe PDF No Adobe PDF No Adobe PDF Support for Layers Support for Layers 
Layer support. Layer support. Layer support. from certain from certain 

authoring authoring 
applications. applications. 

Supports object
level metadata.

Table 1-1 lists a comparison of attributes of the different PDF versions and should not be 
confused with certain features you can employ in one release that may make the PDF unus-
able to users with earlier versions of Acrobat. For example, embedding movie clips in a PDF
document or using a JavaScript that won’t work in earlier versions is not a function of the
PDF version. Rather, they are features added to the program and employed after the PDF has
been created.

One of the nice new features of Acrobat Professional with the current PDF version is support
for PDF/A files. If you want to be certain your files are saved in an archive format that can be
opened several years in the future, you’ll want to know more about the new PDF/A archiving
format.

For information related to PDF/A, see Chapter 8.

Acrobat Environment
Experienced Acrobat users will immediately notice the user interface (UI) in Acrobat 7 appears
very similar to the UI introduced in version 6. If you’re updating from Acrobat 4 or 5 then the
UI is probably overwhelming to you. There’s a lot to absorb when looking at the Acrobat win-
dow and you’ll need some initial help to understand all the changes. Fortunately you bought
this book and, together with Adobe Systems and the new help features in all Acrobat viewers,
I’ll walk you through the many different items located in the Acrobat workplace.

Acrobat provides you with features such as menu commands, toolbars, and palettes to accom-
plish work for whatever goal you hope to achieve with PDF documents. When you launch the
program you see many of these features in the Acrobat window. Just so you know what is
being referred to when I discuss accessing a feature in Acrobat, take a look at Figure 1-1 to
understand the names used to describe the various areas of the new Acrobat workplace.

Cross-
Reference

07_583786 ch01.qxd  1/31/05  10:28 PM  Page 9



10 Part I ✦ Welcome to Adobe Acrobat

Figure 1-1: The Acrobat Professional workplace contains menus, toolbars, and palettes.

A Title bar: By default, the name of the file you open appears within parentheses in the
Title bar. The title appearing in the Title bar can change according to an option for dis-
playing the Document Title in the Open Options dialog box.

For information related to Open options and displaying Document Titles, see Chapter 5.

B Menu bar: The menu bar contains all the top-level menu commands. These menu
choices are also available from various actions associated with links and form fields
when you choose the Execute a menu item command in the Actions Properties dialog
box for links, form fields, and other features that permit associating an action with a
command.

For information related to link actions and the Execute a menu item command action type,
see Chapter 17. For more information on actions with form fields, see Part VI.

C Toolbar: A number of individual toolbars are nested below the menu bar. Individual
toolbars are marked with a vertical separator bar at the left side of the toolbar. This bar
can be selected and dragged to move it out of the Toolbar Well.

For information related to working with toolbars, see the “Tools and toolbars” section later in
this chapter.
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D Toolbar Well: The Toolbar Well houses the toolbars. You can drag toolbars away from
the Toolbar Well or add other toolbars and expand the Toolbar Well to house your
new additions. When you drag a toolbar away from the Toolbar Well, the toolbar is
“undocked” and becomes a floating toolbar. When you drag a floating toolbar and drop
it in the Toolbar Well, the toolbar becomes “docked.”

E Palette pull-down menu: Individual tabs can be tucked away in the Navigation pane
(see Navigation pane later in this list) or appear anywhere in the Acrobat window. Each
palette contains its own menus accessible by clicking the down-pointing arrow. These
menus are referred to as palette pull-down menus in all subsequent chapters.

F Bookmarks tab: The first of the default tabs appearing in the Navigation pane is the
Bookmarks tab. If bookmarks are contained in the PDF document they appear in the
palette when the palette is open, as is shown in Figure 1-1.

For information related to creating bookmarks from authoring programs, see Chapter 7. For
information related to creating and managing bookmarks in Acrobat, see Chapter 17.

G Signatures tab: If digital signatures are included in your PDF document, they can be
viewed in the Signatures tab.

For information related to digital signatures, see Chapter 21.

H Layers tab: Acrobat supports layers that have been created from some authoring appli-
cations and exported as a PDF file with layers intact in versions 6 and 7. The Layers tab
enables you to view or hide layers when they are present in the PDF.

For information related to working with layers, see Chapter 19.

I Pages tab: Users of versions of Acrobat prior to version 6 will notice there is no tab for
Thumbnails. The Thumbnails tab was renamed in version 6 to the Pages tab. When you
open the Pages tab, you’ll see thumbnail images of each page in your document and
you’ll find many page-editing features available to you from the Pages tab palette pull-
down menu.

For information related to using the many options available in the Pages tab, see Chapter 12.

J Comments tab: A major overhaul to the Comments tab was made in version 6, and
Acrobat version 7 continues with the same palette design. When you open the
Comments tab, the display of comments and reviews is shown horizontally at the 
bottom of the Acrobat window.

To learn how to use the Comments tab options, see Chapter 15.

K Attachments: A new pane has been added in Acrobat version 7 to display all file attach-
ments in a document. When usage rights are permitted for Adobe Reader users, the
attachments are accessible in Adobe Reader.
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12 Part I ✦ Welcome to Adobe Acrobat

To learn how to use file attachments, see Chapter 15. To learn how to deploy usage rights for
Adobe Reader users, see Chapter 3.

L Bookmarks: Figure 1-1 shows the Bookmarks tab opened with bookmarks listed in the
palette. Bookmarks enable you to jump to the page view associated with the bookmark.
In addition, you can assign attributes other than views to bookmarks, such as opening/
closing files, running a menu command, invoking a JavaScript, and many other actions.

For information related to link actions associated with bookmarks, see Chapter 17.

M Navigation pane: The Navigation pane can be expanded or collapsed. The view in
Figure 1-1 is an expanded view where the Bookmarks tab is the active pane. To open
the Navigation pane you can click a tab to display the respective information associ-
ated with that tab in the expanded palette window. Clicking again on the tab collapses
the view. You can also use the keyboard shortcut F4 to expand and collapse the
Navigation pane.

N Document pane: The Document pane is the container for PDF files you see in Acrobat.
When no file is open, the Document pane is empty. When you open a PDF document,
the document appears in the Document pane.

O Status bar: The status bar contains viewing tools for zooming, page navigation, page
modes, and page layout, and displays information about your PDF document. You can
see the current zoom level and the number of pages in the open PDF at a glance in the
status bar, as shown in Figure 1-1 where page 1 of 758 is displayed. You can navigate
pages in the status bar by clicking on a navigation tool (represented by the arrows),
entering a number in the status bar, and pressing Enter/Return on your keyboard. You
can change page layout views by selecting one of the four tools on the far right side of
the status bar.

For information related to navigation with the status bar, see Chapter 4.

P How To pane: The How To pane enables you to obtain instant help with menu com-
mands, tools, palette options, and many selected tasks you perform routinely. When
you invoke a search in Acrobat the How To pane is replaced with the Search pane. By
default, the How To pane opens when you first launch Acrobat. You can toggle the pane
off by deselecting the check box for Show How To Window at Startup on the home page
in the How To pane.

For information on using the How To pane, see the “Accessing Help” section later in this
chapter.

For more detail on specific menu commands, tools, and palettes, see the related chapters to
discover the different options available to you. All of the items discussed here are explained
in more depth in subsequent chapters.
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13Chapter 1 ✦ Getting to Know Adobe Acrobat

Menus
Like any program operating on a computer system that supports a windows type of environ-
ment, you’ll notice menu commands at the top level of the Acrobat window. Users of previous
versions will notice different menu commands have been relocated under different menu
headings. If at first glance you don’t see an option you used in Acrobat 6, poke around the
menus. None of the Acrobat 6 features have been eliminated; they may just be in a different
place or referred to by a different name. 

File menu
The File menu is where you open and close documents, create PDF files, import

and export certain data, access print commands, and find some other nifty new
additions in Acrobat. The Mac and Windows operating systems display recent files in
different menus. On the Mac in OS X you’ll find recently viewed documents by choosing
File ➪ Open Recent File. This command opens a submenu where you can access recent
documents. On Windows, a list of the recently viewed documents is located at the
bottom of the File menu, as shown in Figure 1-2.

Figure 1-2: Recently opened files in 
Windows appear at the bottom of 
the File menu. Macintosh users can 
display a list of recently viewed files 
by choosing File ➪ Open Recent File.
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14 Part I ✦ Welcome to Adobe Acrobat

The Form Data menu command, shown in Figure 1-2 is only available in Acrobat
Professional. Save a Version and Versions appear only in Acrobat Professional when Version
Cue is enabled.

You’ll note that the My Bookshelf command has been eliminated and a new file management
tool called Organizer now appears in the File menu.

For information related to using the Organizer, see Chapter 4. For information about saving
versions, see Chapter 9.

Edit menu
As shown in Figure 1-3, the traditional Cut, Copy, and Paste commands are located

in the Edit menu along with other familiar commands from Acrobat 6. No changes
appear in the Edit menu in Acrobat 7 than were present with Acrobat 6.

Figure 1-3: The Edit menu 
contains the same commands 
found in Acrobat 6.

View menu
The View menu (see Figure 1-4) contains all the commands you’ll use for viewing

PDF documents. Additions to the View menu include items such as Wireframe and
Tracker. Wireframe mode displays all lines at one point for easier viewing when you
zoom out on drawings. You can launch the Review Tracker from either this menu
command or the Tracker command in the Comment & Markup Task Button.

Wireframe, Grids, Guides, and Rulers are available only in Acrobat Professional.Note
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15Chapter 1 ✦ Getting to Know Adobe Acrobat

Figure 1-4: The View menu 
contains commands for viewing 
PDF documents and navigating 
through pages and different 
PDF files. This menu contains the 
commands for many of the 
new features appearing in 
Acrobat Professional.

For information related to Wireframe viewing see Chapter 4. For information on tracking
reviews, see Chapter 16.

Document menu
The Document menu (see Figure 1-5) contains a collection of commands

specific to document handling. Options in the Document menu have changed
substantially in Acrobat 7 compared to the options in Acrobat 6. Notice a new
command — Attach a File — at the top of this menu handles attaching files to PDF
documents. This command does not create a file attachment as a comment as you
might use with the Attach a File as a Comment tool. Recognize Text Using OCR is a new
label for Paper Capture (used in Acrobat 6) and now more intuitively describes the
function. Set Page Transitions is a new command in this menu and simply duplicates the
same command contained in the Pages pane. Below Set Page Transitions you’ll find
various commands for handling pages. These commands were previously displayed in
the Pages submenu in Acrobat 6.

Cross-
Reference
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For information related to attaching files, see Chapter 15. For information related to deploy-
ing documents for Reader users to extract attachments, see Chapter 3. For information
related to Print Production, see Chapter 25. For information on recognizing text as OCR (opti-
cal character recognition), see Chapter 13. For information on setting page transitions, see
Chapter 23.

Menu commands that have been eliminated from the Document menu in Acrobat 7 compared
to Acrobat 6 are the Pages submenu, Import Comments, Export Comments to Word, Add a
Comment (which now appears in the Comment & Markup Task Button described as Add a
Note), and Summarize Comments. The Preflight command has also been eliminated from the
Document menu and relocated to the Tools ➪ Print Production submenu.

Most of the aforementioned Comments-related commands have now been moved to the new
Comments menu. For example, this is where you go to print comments with a summary. The
Summarize Comments command is also available in the Comments pane Options menu as in
Acrobat 6. In Acrobat 6 you opened a dialog box to manage comments. In Acrobat 7 you man-
age comments in the new Comments menu. 

For information related to adding comments, summarizing comments, and using the
Comments menu, see Chapter 16. For information related to Print Production and pre-flighting,
see Chapter 25.

Figure 1-5: The Document 
menu reflects several changes 
in Acrobat 7. 

Comments menu
New in Acrobat 7 is a separate menu for handling comments. In addition to the

Comments pane that also provides tools and menu commands, the Comments menu (see
Figure 1-6) provides access to commenting tools as well as commands for importing and
exporting comments, adding a note, opening the Comments pane, enabling commenting
for Adobe Reader users, printing documents with comments, opening the commenting
preferences, and access to help information related to commenting.

For details on all the menu commands in the Comments menu, see Chapter 15.Cross-
Reference

Cross-
Reference

Cross-
Reference
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Figure 1-6: The new Comments menu 
offers commands specific to review 
and markups.

Tools menu
The Tools menu (see Figure 1-7) in Acrobat logically places access to many

editing tools in a single convenient menu. You can access certain tools from the Acrobat
toolbars (explained in the section “Tools and toolbars” later in this chapter) or you can
use a context menu to access toolbars from the Acrobat Toolbar Well. The difference
between the menu command in the Tools menu compared to both the View menu and
a context menu is the Tools submenus give you direct access to individual tools as
opposed to toolbars. When you load a toolbar, several individual tools appear in the bar.

Figure 1-7: The Tools menu contains a collection of tools
accessed from submenus. Select a tool group from the menu
options to open a submenu.

Measuring, Drawing Markups, and Print Production tools are available only in Acrobat
Professional.

Note
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Advanced menu
The Advanced menu (see Figure 1-8) contains a collection of menu commands

considered to be advanced Acrobat features. A few of these tools are not available to
users of Acrobat Standard such as Batch Processing and access to Acrobat Catalog.
Some menu names have been changed and some commands found in Acrobat 6 such as
the PDF Optimizer have been relocated to other menus.

Figure 1-8: The Advanced menu 
offers menu commands related to 
advanced editing features.

For information related to Batch Processing, see Chapters 14 and 29. For information on
using Acrobat Catalog, see Chapter 5.

Window menu
The Window menu (see Figure 1-9) provides menu commands to assist you in

viewing documents. A new Spreadsheet Split view has been added to Acrobat 7 where
you can split a document into several panels for viewing similar to spreadsheet views.

Cross-
Reference
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Figure 1-9: The Window 
menu handles all the 
window views such as tiling, 
cascading, and the new 
feature for displaying a split 
window.

For information related to window views and the split window views, see Chapter 4.

Help menu
The traditional help files added to your Acrobat folder at installation are found in

the Help menu (see Figure 1-10). The previously named How To pane is now labeled
Help and offers the same access to the complete Acrobat Help document installed with
your application. Topics have been reorganized in the Help pane and now give you
quick access to many different Acrobat features, including new help topics such as
Forms, Print Production, and Engineering tasks. As is the case in Acrobat 6, you can use
the Complete Acrobat 7.0 command to open a complete help document that you can
search so you can find help information fast.

Figure 1-10: The Help menu gives 
you access to Help information on 
selected topics as well as access 
to the complete Acrobat Help 
document.

Cross-
Reference
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For information related to Help documents and Help menus, see the “Accessing Help” sec-
tion later in this chapter.

Submenus
An extensive number of submenus appear in menus contained in the top-level menu bar and
from many different tools contained in toolbars. Note that on individual toolbars you see a
down-pointing arrow. Clicking the arrow opens a menu; some menus contain submenus. A
submenu is denoted in Acrobat by a right-pointing arrow on the right side of a given menu
command. Select a command with one of these arrows adjacent to the command name and a
submenu opens. In a few cases, you can find nested submenus where another right-pointing
arrow may be visible in a submenu, as shown in Figure 1-11. If you want to access the second
submenu, move the cursor to the menu option containing a right-pointing arrow. To make a
selection from a submenu command, move the cursor to the desired menu command. When
the menu command highlights, click the mouse button to execute the command.

Figure 1-11: To access a submenu, move the cursor to the command containing a 
right-pointing arrow and slide the cursor over to the submenu options. Click the desired 
command in the submenu to execute the command.

Context menus
Wherever you are in the Acrobat window — the toolbars, palettes, Document pane, or the
Help menus — you can gain quick access to menu items related to your task by opening a
context menu. Context menus pop up in an area where you either click the right button on
the mouse or use an appropriate key modifier. In Windows, right-click the mouse button to

Cross-
Reference
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open a context menu. On a Macintosh, when not using a two-button mouse, press the Control
key and click the mouse button. Context menu options relate to the particular tool you have
selected from a toolbar. By default the Hand tool is selected when you launch Acrobat and
open a PDF document. When you right-click the mouse button (Windows) or Control+click
(Macintosh), a context menu pops up where you click the mouse as shown in Figure 1-12.

Figure 1-12: With the Hand tool 
selected, right-clicking (Windows) 
or Control+clicking (Macintosh) 
the mouse button opens a 
context menu. From the menu, 
scroll the list and select the 
desired menu command.

If you change tools in a toolbar and open a context menu, the menu options change to reflect
choices with that particular tool. Likewise, a context menu opened on a palette offers menu
options respective to the palette, as shown in Figure 1-13.

Figure 1-13: When a palette is open 
in the Navigation pane and you 
open a context menu, the menu 
options reflect tasks you can perform 
respective to the palette.

In order to open a context menu on a palette, the palette must be open in the Navigation
pane. Clicking the tab for the palette name doesn’t open a context menu.

Note
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Context menus are a great benefit during your Acrobat sessions and using them helps you
work much faster. Throughout this book I often make references to the different choices you
have in selecting a tool or command. In most incidences, you find mention of context menus.
Be certain you know how to open a context menu in Acrobat on your computer. For the
remainder of this book I’ll mention opening context menus without walking through the steps
for how to open the menu.

Keyboard shortcuts
Pressing one or more keys on your keyboard can also open menus and invoke different com-
mands. When you become familiar with keyboard shortcuts that perform the same function
as when using a menu or context menu, you’ll find yourself favoring this method for making
different menu selections or grabbing a tool from a toolbar. Fortunately, you can learn as you
work when it comes to memorizing keyboard shortcuts. As I’m certain you know, several
shortcut combinations are noted in menu commands. You can learn these shortcuts when
you frequently use a particular command. However, the keyboard shortcuts you see in the
menu commands are just a fraction of what is available in Acrobat for quick access to com-
mands and tools. For a complete list of all keyboard shortcuts, look over Appendix A. You can
use the appendix to refresh your memory on shortcut keys as you work through the program.

Pressing a single key to access a tool requires you to have your Preferences set to accept sin-
gle keystroke shortcuts. See the steps for “Setting up the Acrobat environment” later in this
chapter for the proper Preferences settings.

Tools and toolbars
Tools are grouped together in separate toolbars in the Toolbar Well below the menu bar. The
default view when you launch Acrobat contains several toolbars visible in the Toolbar Well.
You can remove various toolbars from the Well, move them around the Acrobat window,
close them, and add different toolbars to the Toolbar Well. The Toolbar Well, where the tool-
bars are contained, is collapsed and expanded according to the number of toolbars you add
to it. When a toolbar is contained within the Toolbar Well, it is said to be docked. When a tool-
bar is dragged away from the Toolbar Well and rests atop the Acrobat window, it is said to be
undocked.

Toolbars often contain nested tools accessible from pull-down menus. When you see a down-
pointing arrow adjacent to a tool, you can click the arrow to open the menu. Many menus
contain an Expand This Button menu command. Selecting this command (see the example
shown in Figure 1-14), expands the toolbar enough to accommodate additional tools. In
Figure 1-15 you can see the File toolbar expanded after the command was selected. 

Figure 1-14: Several tools contain pull-down menus 
with an Expand This Button menu command, which 
you use to expand the toolbar to accommodate 
more tools.

Note
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Default toolbars
When you launch Acrobat for the first time or you set the toolbars to the default view, six dif-
ferent toolbars are docked in the Toolbar Well. The default toolbars include

✦ File toolbar: These tools are used for general document handling. The File tools acti-
vate commands for Open, Open Web Page, Save, Print, Open Organizer, Attach a File,
Attach a File as a Comment, Email, and Search. In Figure 1-15 the File Toolbar is
expanded.

Figure 1-15: The File Toolbar contains 
tools for document handling, such as 
opening PDF documents, saving 
documents, and printing files.

✦ Tasks Toolbar: Task tools are used for editing tasks and document handling. The tools
handle Acrobat tasks such as Create PDF, Comment and Markup, Send for Review,
Security, Digital Signatures, and Forms. All of these tools have toolbar pull-down
menus. Notice in Figure 1-16 the down-pointing arrow appearing to the right of all the
tools in this group, indicating they all have pull-down menus.

Figure 1-16: The Tasks Toolbar contains tools used 
for specific Acrobat tasks such as creating PDFs, 
reviewing documents, adding digital signatures, 
and so on.

✦ Basic Toolbar: Among the Basic tools, shown in Figure 1-17, are the Hand tool, Select
tool, and the Snapshot tool. In Acrobat 7 the Select tool combines tasks for selecting
either text or graphics. The order of selection in terms of what is selected first (either
text or graphics) is controlled with a Preferences setting.

Figure 1-17: The Basic Toolbar contains tools for selecting text and
graphics. The default Hand tool is selected when you open Acrobat at
the start of each session.

For more information on changing Preferences, see “Understanding Preferences” later in this
chapter.

Cross-
Reference
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✦ Zoom Toolbar: The tools in this group (see Figure 1-18) are used to zoom in and out of
pages in the Document pane.

Figure 1-18: The Zoom tools handle 
zooming in and out of the current 
active document.

✦ Rotate View Toolbar: The Rotate View tools, shown in the expanded toolbar in
Figure 1-19, are used to rotate pages in the Document pane. When these tools are
used to rotate pages, the rotated views cannot be saved.

Figure 1-19: Use the Rotate View tools to temporarily rotate pages while
viewing a document.

✦ Help Toolbar: Help topics are readily available to you in Acrobat via the Help pane. A
list of Help items is contained in the pull-down menu shown in Figure 1-20 as well as
access to the complete Acrobat Help document.

Figure 1-20: The Help Toolbar 
enables you to obtain help for 
many common editing tasks 
in Acrobat.

Managing default toolbars
As mentioned previously, toolbars can be moved, docked, and undocked from the Toolbar
Well. Here’s a list of some of the things you can do with the default toolbars and any other
toolbars you decide to view:

✦ Undocking toolbars: Toolbars can be relocated from within the Toolbar Well to another
area within the Acrobat window. For example, you might find it more convenient to
move a toolbar you frequently access during an editing session so it is positioned at
the bottom of the Document pane. If so, just place the cursor on top of the vertical 
separator bar adjacent to the first tool in a toolbar and drag it away from the Toolbar
Well, as shown in Figure 1-21. This vertical line is the hot spot used to select the toolbar
instead of a tool in the group. Clicking anywhere else in the toolbar selects a tool.
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Figure 1-21: Move toolbars around the Acrobat window by selecting the vertical separator
adjacent to the first tool in a toolbar and dragging it away from the Toolbar Well.

✦ Docking toolbars: To dock a toolbar back in the Toolbar Well once removed, drag 
the toolbar, again by the vertical separator bar adjacent to the first tool, on top 
of the Toolbar Well. The toolbar snaps to an available position in the well. If you drop
the toolbar between two other toolbars, the toolbar you relocate back to the Toolbar
Well snaps in position between the two docked toolbars.

Toolbars can also be docked vertically on the left and right sides of the Document pane
and at the bottom of the Acrobat window below the status bar. For example, if you drag
a toolbar to the left of the Navigation pane and release the mouse button, the toolbar
snaps to a docking station and the tools display vertically. In Figure 1-22 you can see
toolbars docked on the left, right, and bottom of the Acrobat window with one floating
toolbar in the Document pane.

✦ Resetting toolbars: You can position toolbars around the Acrobat window and return
them to the default positions with one menu command. This is particularly helpful if
multiple users work on a single computer or you frequently change editing tasks that
require using different tools during different editing sessions. In many cases it’s easier
to reset toolbars to the original default view, than open tools needed for a specific edit-
ing task. To set toolbars to their defaults, open a context menu from any toolbar or in
the Toolbar Well by right-clicking (Control+clicking on Macintosh), and select the menu
item Reset Toolbars as shown in Figure 1-23.
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Figure 1-22: Toolbars can be docked on all four sides of the Acrobat window.

Figure 1-23: To return toolbars back to the default view, open
a context menu from any toolbar or in the Toolbar Well and
select Reset Toolbars.
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When you dock a toolbar on the left, right, and/or bottom of the Acrobat window, the empty
area surrounding the toolbar becomes a Toolbar Well. Context menus can be opened from
any Toolbar Well and menu commands appear the same as shown in Figure 1-24.

✦ Hiding all toolbars: Toolbars can be hidden from view to offer you more room when
editing a PDF document or browsing the contents of PDFs. If you master some of the
keyboard shortcuts shown in Appendix A, you can move about PDF files in the
Document pane or perform many different editing tasks without the toolbars in view.
To hide the toolbars from view, open a context menu from the Toolbar Well and choose
Hide Toolbars. When toolbars are hidden you won’t have access to a context menu to
get the toolbars back in view. Instead, choose View ➪ Toolbars ➪ Show Toolbars or
press the F8 key on your keyboard to make all toolbars reappear. (Note that using this
menu command also hides toolbars.) Alternately, you can click the Hide/Show toolbars
in the lower left corner of the Status Bar.

✦ Hiding a single toolbar: You can hide a toolbar after it has been undocked from the
Toolbar Well. Click the X in the top-right corner of the toolbar (Windows) or the small
circle on the top-left side of the toolbar (Macintosh) to close it, and it disappears from
view. From a context menu opened on any toolbar or the Toolbar Well you can open the
toolbar and display it in the Acrobat window again.

✦ Locking toolbars: The vertical separator bar used to move toolbars disappears when
you select Lock Toolbars from a context menu. The toolbars cannot be inadvertently
moved after you lock them. To unlock the toolbars, open a context menu and select
Lock Toolbars again. The check mark alongside the menu command becomes
unchecked and the toolbars are unlocked in the Toolbar Well. If the toolbars are locked
and you drag an undocked toolbar on top of the Toolbar Well, it won’t dock. You need
to first unlock the toolbars before you can redock them.

You can also lock toolbars that are undocked outside of the Toolbar Well. The separator bar
on the toolbar disappears on floating toolbars the same as it does for toolbars docked in the
Toolbar Well. However, locking undocked toolbars does not prevent you from moving them
around the Acrobat window. You can click and drag the title bar for any undocked toolbar
and move it to another location.

✦ Setting new toolbar defaults: If you decide to reposition your toolbars and want to keep
them fixed as new defaults, Acrobat can do so for you automatically. Move the toolbars
to the desired locations and go about your work. When you quit Acrobat and reopen
the program, the toolbar positions remain as you last arranged them. Unfortunately,
Acrobat does not have a Save Workspace command like you find in several Adobe
Creative Suite applications.

If you are unfamiliar with many Acrobat tools, you can change the tool labels to show you a
more descriptive label for each tool that offers you a hint of what the tool does. To show
more descriptive labels, open a context menu on the Acrobat Toolbar Well and choose Show
Button Labels ➪ All Labels. The toolbars expand and show a text description for each tool’s
name. Keep this option active until you are familiar with the tool names.

Understanding advanced toolbars
The default toolbars represent less than half of the tools available to you in Acrobat. Many
of the other toolbars remain hidden from view. The reason for this is obvious when you load
all the toolbars in the Toolbar Well. You lose a lot of viewing real estate when all toolbars are

Tip

Note

Note
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docked in the Toolbar Well. Unless you have a large display monitor or a second monitor,
working on a file in the Document pane when all toolbars are in view gives little room to see
document pages. Fortunately, by managing the toolbars you can elect to show only the tools
you want to work with and you can move them around the Acrobat window, allowing for the
best view.

Turn back to Figure 1-1 in this chapter to see all the toolbars docked in the Toolbar Well.

You open toolbars from menu commands in the Tools menu or by opening a context menu. If
you’re a seasoned Acrobat user, your first encounter with Acrobat viewers 6 and above might
be a bit frustrating if you don’t know how to access the tools you want to use. “Where is that
Form tool?” you may ask. Don’t worry; it’s there. You just have to poke around and search for
it, or better yet, look over the following descriptions to understand more about how these
other tools are grouped into separate toolbars.

Acquiring advanced toolbars
For the purpose of discussion, I’ll refer to the non-default toolbars as advanced toolbars.
Acrobat does not refer to all these tools as advanced tools. Some of the tools labeled in the
menu commands are not referred to as advanced tools. For clarity in this chapter, though,
consider all the following toolbars as advanced toolbars.

You can use three methods for displaying toolbars not visible when you open Acrobat. You
can open the View ➪ Toolbars menu where you find a list of tools in submenus. Select a sub-
menu item to open a toolbar as a floating toolbar in the Acrobat window. Another method is
to open a Task Button pull-down menu and select a menu command to show a toolbar. Not all
the toolbars are accessible from Task Buttons so you need to use other methods if a toolbar
you want to open is not contained in a Task Button pull-down menu. The third method, and
perhaps the easiest way to access tools, is to open a context menu on the Toolbar Well. As a
matter of routine, you should use this option, as it’s the fastest method for opening and clos-
ing tools. All tools except the Form tools (Acrobat Professional only) are accessible from the
context menu.

Advanced Editing tools
When you open either the View ➪ Toolbars submenu menus or a context menu on the
Toolbar Well, the first menu option is Advanced Editing. Select the menu option and the
Advanced Editing tools open in their own toolbar.

Down arrows in the toolbar denote where you can open pull-down menus. Click a pull-down
menu, and various other tools appear as additional choices. When you click the down arrow
to open a pull-down menu adjacent to the Button tool (Acrobat Professional only) as shown
in Figure 1-24, the menu options show the different Form tools and a menu command for
showing the Forms toolbar. The Forms toolbar needs to be opened from this menu command
as it’s not accessible in either the View ➪ Tools submenu or from a context menu opened on
the Toolbar Well.

The Advanced Editing tools offer you a set of tools to edit documents with articles, crop
pages, add form fields, add movies and sound (Acrobat Professional only), and edit text.

Advanced Editing tools are described throughout Parts III and IV. Cross-
Reference

Cross-
Reference
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Figure 1-24: Selecting the down-pointing arrow adjacent 
to the Button tool opens a menu where you select 
form tools.

Commenting tools
The Commenting tools, shown in Figure 1-25, are used in review sessions to mark up and
comment on documents, much like you might use pens, highlighters, and diagrams in an ana-
log review session.

To learn how to use each of the Commenting tools, see Chapter 15.

Figure 1-25: Use the Comment tools to mark up
documents during a review.

Drawing Markups tools
Acrobat divides the comment tools into two categories. The tools in the Commenting Toolbar
are used typically with office documents, reports, manuals, letters, and so on commonly
found in regular business environments. The Drawing Markups tools shown in Figure 1-26 can
be used in these environments as well, but the intent for the use of these tools is focused on
engineers and technical professionals. 

To learn how to use the Drawing Markups tools, see Chapter 15.

Figure 1-26: Drawing Markups tools are used to 
mark up technical documents during a review.

Cross-
Reference

Cross-
Reference
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Edit tools
The Edit tools, shown in Figure 1-27, are limited to spell checking (comment notes and form
fields only), and Undo, Redo, and Copy a selection. These simple edit commands are found in
most programs running on Windows and the Macintosh.

Figure 1-27: The Edit Toolbar contains tools for spell checking, and
Undo, Redo, and Copy a selection.

Find tool
Early versions of Acrobat had a Find tool used to find text in open documents. In Acrobat 6,
the Search pane was used to find text in open documents as well as to run searches across
documents and through search index files. In Acrobat 7, the Find tool returns, as shown in
Figure 1-28. Use of this tool is limited to searching text in an open document. 

Figure 1-28: Use the Find tool 
to search text in the active 
open document.

To learn how to use the Find tool and understand more about using Search in Acrobat view-
ers, see Chapter 5.

Measuring tools
The Measuring tools include the Distance tool used for measuring linear distances, the
Perimeter tool for measuring linear distances of angles and objects, and an Area tool for 
measuring the surface area of objects. The Measuring Toolbar, shown in Figure 1-29, might
be used for examining measurements in engineering and scientific drawings.

For more information about using the Measuring tools, see Chapter 15.

Figure 1-29: The Measuring Toolbar offers three tools to measure distances
and areas on a PDF page.

Navigation tools
Because so many different ways exist for paging through PDF files, having the Navigation
tools visible as a default isn’t really necessary. The status bar contains all the navigation tools
you need. Nonetheless, the Navigation Toolbar is available to you and might be used in
instances where the document window controls have been hidden. In this case, you might
open the toolbar, shown in Figure 1-30, to navigate pages.

Figure 1-30: The Navigation Toolbar is not visible when Acrobat
opens with default toolbars in view. To access the Navigation
tools choose View ➪ Toolbars ➪ Navigation or use a context menu.

Cross-
Reference

Cross-
Reference
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For more information regarding navigating PDFs, see Chapter 3. For information on hiding
window controls, see Chapter 4.

Object Data tool
The Object Data tool (see Figure 1-31) is used to select objects on a document page. When
you select an object that has object data associated with it, the Object Data dialog box opens.
This dialog box contains object metadata that was added by PDF authors using programs
such as Microsoft Visior Project, Autodesk AutoCAD, and other programs that support sup-
port object data. Object Data might include asset information on objects that are shown on
diagrams such as costs, object attributes, inventory, catalog information, and so on.

For a greater understanding about object and document metadata, see Chapter 4. For infor-
mation on using the Object Data tool, see Chapter 7.

Figure 1-31: Use the Object Data tool to select objects and view file
attributes associated with the selected object.

Print Production tools
The Print Production tools (see Figure 1-32) enable you to make adjustments on the PDF or
alter the content. This toolbar contains tools for assigning traps, pre-flighting, converting 
colors, assigning color profiles, adding crop marks, cropping pages, fixing hairlines, trans-
parency flattening, and assigning Job Definitions.

Figure 1-32: Use the Print Production tools to 
open dialog boxes where you can preview and 
change PDF documents to accommodate 
prepress and commercial printing. 

For more information on using Print Production tools and preparing files for commercial
printing, see Chapter 25.

Properties Bar
You use the Properties Bar (see Figure 1-33) in conjunction with several different tools. After
you create comments, links, buttons, and similar content in a PDF document, the selected
comment, link, button, and so on displays current properties such as colors, fonts, and line
weights in the Properties Bar. You can make changes in the Properties Bar without visiting
the Properties dialog box. You can quickly open the Properties Bar with a keyboard shortcut
(Ctrl/Ô) or via context menu.

Figure 1-33: The Properties Bar offers a quick solution 
for editing item properties without the need for opening 
dialog boxes.

Cross-
Reference

Cross-
Reference

Cross-
Reference

07_583786 ch01.qxd  1/31/05  10:28 PM  Page 31



32 Part I ✦ Welcome to Adobe Acrobat

Customizing the Acrobat workplace
Whether you’re an Acrobat pro or a new Acrobat user, seeing all those toolbars scattered
across the Toolbar Well the first time can be very intimidating. As you poke around and possi-
bly feel a little frustration when trying to identify the right tool icon to select the right tool for
the task at hand, please realize that Acrobat is a multifaceted program serving a huge array
of needs for different users. Not all the tools and features are designed for use in a single
Acrobat session. You may be a PDF forms author and need only Basic tools, Navigation tools,
and Form tools. In another session you may be a reviewer and only have need for the Comment
and Markup tools. You might be an eBook author and need to work with many features for
creating and viewing eBooks, or you might want to edit PDF pages and post modified PDFs on
your Web site.

When learning all the tools and commands contained in Acrobat Professional, be certain
to look over all the chapters where tools are discussed. Learn how to access toolbars and
organize them in the Toolbar Well. When you begin a new Acrobat session, set up your envi-
ronment so you can easily select a tool from toolbars you dock in the Toolbar Well. Frequently
return to Appendix A and look over the keyboard shortcuts to learn how to quickly access
the tools you use most frequently.

As a starting point, you can configure Acrobat to provide you with immediate feedback related
to tools selection and keyboard shortcuts. As you first start using Acrobat Professional, fol-
low the steps in the next section to help you customize your environment for more efficient
editing and less frustration. In this example, an environment for engaging in a commenting
session is used. You can change the toolbars to meet needs in PDF editing or PDF creation, or
add tools for some other kind of work you do.

STEPS: Setting up the Acrobat environment
1. Return to toolbar defaults. Open Acrobat. Position the cursor on any toolbar or an

empty area in the Toolbar Well and right-click to open a context menu (Ctrl+click for
Macintosh) and select Reset Toolbars.

2. Show a toolbar. Open the Tools menu and select the first toolbar you need to add to
the Toolbar Well for easy access to the tools you intend to use. In this example, I select
Tools ➪ Commenting to open the Advanced Editing toolbar.

3. Dock the toolbar in the Toolbar Well. Click the separator bar on the floating toolbar in
the Acrobat window and drag it toward the Toolbar Well. Release the mouse button
when the toolbar is on top of the Toolbar Well.

4. Add additional toolbars for tools you intend to use. If you need more tools, follow the
previous steps and add just the toolbars containing the tools you expect to use in your
editing session. In this example I open a context menu on the Toolbar Well and select
Drawing Markups and then return to the context menu and load the Measuring toolbar.
Open a context menu on the Acrobat Toolbar Well and select Properties Bar.

5. Dock the floating toolbars. To use another method for docking toolbars, open a con-
text menu on the Toolbar Well and select Dock All Toolbars.

6. Show all button labels. Open a context menu on the Toolbar Well and select Show
Button Labels ➪ All Labels. Showing all the labels provides you a clear description for
the tools contained in the Toolbar Well.
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7. Open the Preferences dialog box. Many tools can be accessed using keyboard short-
cuts. In order to use keyboard shortcuts, you need to adjust a preference setting in the
Preferences dialog box. On Windows, choose Edit ➪ Preferences. On the Mac, choose
Acrobat ➪ Preferences. You can also use the keyboard shortcut Control/Ô+K.

8. Enable single-key accelerators. Click General in the left pane of the Preferences dialog
box. In the Miscellaneous section in the right pane, check the box for Use single-key
accelerators to access tools. When this check box is selected, you can press a single
key on your keyboard to access respective tools. For example, press the H key to select
the Hand tool. Press the Z key to select the Zoom In tool. Pressing Shift+Z toggles all
the zoom tools each time you press the keys.

9. Exit the Preferences dialog box. After making your preference choices, click OK in the
dialog box. New preference choices take effect without your having to restart the pro-
gram. In Figure 1-34 you can see the Acrobat Workplace configured for working with
comment and markup. Note that many tools are accessible only when you have a PDF
document open in the Document pane.

Figure 1-34: Toolbars are loaded and docked in the Toolbar Well.

Tool Tips
When you select All Labels from a context menu or preference setting, you see tool descrip-
tions on many tools. However, not all tools describe the tool with a label. For example, look at
the Zoom In tool (the magnifying glass with a plus symbol). It should be apparent to you what
the tool does by viewing the icon in the toolbar. Other tools’ functions, however, may not be
so apparent from viewing the tool icons. Fortunately, you have some extra help in the form of
Tool Tips. To view a Tool Tip, place the cursor over a tool in the Toolbar Well or on a floating
toolbar, and pause a moment before selecting the tool. A Tool Tip appears inside a yellow box
directly below the cursor with a label describing the tool. In Figure 1-36 you can see the Tool
Tip that appears when the cursor is placed over the Snapshot tool. As you move the cursor
over different tools, the Tool Tips change to reflect the description of the targeted tool as well
as the keyboard shortcut used to make the tool active. Note the (G) in Figure 1-35, indicating
that pressing the G key on your keyboard selects the Snapshot tool.

Figure 1-35: Place the cursor over a tool and pause a moment before
selecting the tool. A Tool Tip describing the tool opens below the
mouse cursor.

As you become familiar with the tools, you can return to the context menu opened from the
Toolbar Well and choose Show Button Labels ➪ No Labels. When No Labels is active, your
toolbars shrink in size and offer you more room in the Toolbar Well.
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Palettes
Other tools available to you in all Acrobat viewers are palettes. Palettes are similar to toolbars
in that they can be docked to a docking station called the Navigation pane; they can be
undocked and floated around the Acrobat window; they can contain pull-down menus for
selecting more options; a series of default palettes appears docked in the Navigation pane;
and you can open additional palettes from menu commands.

A couple distinctions between toolbars and palettes are that palettes can be placeholders for
information, and tools can appear inside a palette. Whereas tools are used in the Document
pane, many palette operations can take place directly in the palette. Toolbars remain relatively
fixed in size, but palettes can be sized and stretched along the Acrobat window to provide you
with more room to work within the palette or view the information contained within the palette.
In addition, some palettes contain their own tools where edits can be made in the palette and
dynamically reflected on the document page. Palettes help you organize content, view specific
content across many pages, and provide some tools for global editing of PDF files.

Default palettes
Like toolbars, Acrobat displays a series of palettes docked in a well when you first launch the
program. Palettes are contained in the Navigation pane along the left side of the Acrobat win-
dow. By default, the Navigation pane is collapsed; however, you can save PDF documents in
such a manner where a palette expands when a file is opened in any Acrobat viewer. These
settings are document-specific and can be toggled on or off for individual PDF documents.

For more information about setting opening views for palette displays, see Chapter 3.

Bookmarks
The topmost default palette tab in the Navigation pane is the Bookmark tab. You can save PDF
documents in a manner where the bookmarks are visible when the file opens in Acrobat. A
good example of such a file is the Acrobat Help file. When you open the Acrobat or Adobe
Reader Help file, bookmarks are visible in an open Navigation pane, as shown in Figure 1-36.
You can open and close the Navigation pane by pressing F4. You can also grab the vertical sep-
arator bar at the right edge of the Navigation pane and move it left and right to size the pane.

Bookmarks are navigation buttons that can launch a page, a view, or one of many different
Action types similar to link and button actions. Anyone familiar with Acrobat already knows
much about bookmarks and how to navigate pages by clicking individual bookmarks in the
palette.

To learn how to create and manage bookmarks and add actions, see Chapter 17.Cross-
Reference
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Reference
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Figure 1-36: Bookmarks can be displayed in the Navigation pane when a file opens.

Signatures
The Signatures tab in the Navigation pane has been repositioned to occupy the second tab
spot from the top of the pane. Users of earlier versions of Acrobat will remember that
Comments followed Thumbnails in Acrobat 5 viewers and appeared third in the list in
Acrobat 6.

Digital signatures help you manage signed documents; the Signatures tab enables you to per-
form tasks such as displaying signatures in the Signature pane, verifying signatures, clearing
them, deleting them, and so on. All these editing tasks with signatures are still available in
Acrobat Professional as is signature validation, which is also available in other Acrobat viewers.

For a complete description of creating and managing digital signatures, see Chapter 21.

Layers
Adobe PDF layers are supported in Acrobat 6 and 7. Earlier Acrobat viewers cannot display
layer views. If you create a PDF document with layers and open the file in viewers earlier than
version 6, the layers are merged into a single layer view also known as flattening layers. The
Layers palette offers you menu options for managing layers as well as turning on and off indi-
vidual layers.

For a complete description of working with layers, see Chapter 19.Cross-
Reference
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Pages
Acrobat users have been familiar with the thumbnail view of each page since the early days
of Acrobat. A mini view of each page in the active PDF document is displayed in the Pages
pane, as shown in Figure 1-37. The Pages pane offers you menu options for arranging, delet-
ing, inserting, and editing pages in a number of ways. You can zoom in to the thumbnail views
as large or even larger than a page viewed in the Document pane.

Figure 1-37: Thumbnails are found in the Pages pane in all Acrobat viewers. The 
thumbnail view of document pages can be sized larger and smaller using context 
menu commands.

For a complete description of working with pages (thumbnails), see Chapter 12.

Attachments
The new Attachments pane (see Figure 1-38) in all Acrobat viewers is used to display, man-
age, and extract file attachments. Now you can attach files in Acrobat Standard and
Professional and extract file attachments using Adobe Reader. 

For a complete description of adding file attachments to PDF documents, see Chapter 15. For
more on extracting attachments from within Adobe Reader, see Chapter 3.

Cross-
Reference
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Figure 1-38: The Attachments pane provides options for managing file attachments. 
Attachments can be extracted from within Adobe Reader.

Comments
The Comments palette shows you comments in an expanded horizontal view, just like the
Attachments pane. When you click the Comments tab, you’ll notice a number of pull-down
menus (signified by down-pointing arrows at the top of the pane), a list of comments that can
be expanded and collapsed, and a host of tools within the palette, as shown in Figure 1-39.

Figure 1-39: The Comments palette

For a complete description of creating and managing comments, see Chapters 15 and 16.Cross-
Reference
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Hidden tabs
As with toolbars, you can choose to view additional tabs through menu commands. You can
choose to display a number of other tabs in the Acrobat window and dock them in the
Navigation pane. To open a hidden tab, choose View ➪ Navigation Tabs. From the submenu,
you’ll find all the tabs available. In Figure 1-40, the list shows Navigation tabs available in Acrobat
Professional. The list includes the default tabs. If you select a default tab, the Navigation pane
opens and the tab is selected. When you select a hidden tab, in other words, a tab other than
those docked in the Navigation pane when you first launch Acrobat, the tab opens in the
Acrobat window as a floating palette with one or more tabs contained in the window.

Figure 1-40: Open the Navigation Tabs menu and a 
submenu displays all Navigation tabs.

To dock a tab from a floating palette to the Navigation pane, select the tab to be docked and
drag it away from the floating palette. Move the tab on top of an expanded Navigation pane or
on top of one of the tabs in a collapsed Navigation pane. When you release the mouse button
the tab is docked in the Navigation pane. If you dock a tab in the Navigation pane and quit
Acrobat, the tab will be in the same position when you launch Acrobat in your next session.

Articles
The first of the hidden palettes listed in the Navigation Tabs submenu is Articles. Choose
View ➪ Navigation Tabs ➪ Articles to open a floating palette. When you open the Articles
palette, both the Articles tab and the Destinations tab appear in the window as shown in
Figure 1-41. Most of the palettes include pull-down menus where you select options.
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Figure 1-41: When you select Articles in the 
Navigation Tabs submenu, the Articles tab 
opens in a palette with the Destinations tab.

Articles enable you to create article threads to help users follow passages of text in a logical
reading order. You won’t find any new features added to the Article tool since Acrobat 5.

For information on creating article threads and managing them, see Chapter 12.

Destinations
The Destinations tab is contained in the same palette as the Articles tab. Destinations work
similarly to bookmarks, in that specific views are captured and listed in the tab. Clicking a
destination opens the associated page in the Document pane, whereas clicking a bookmark
opens the associated view (page and zoom).

For information on creating destinations and managing them, see Chapter 17.

Content
A palette designed for managing the structural content of PDF documents is found in the
Content tab. When you choose View ➪ Navigation Tabs ➪ Content, the Content palette opens
in a floating palette with the Fields, Tags, and Order tabs, as shown in Figure 1-42. Content fea-
tures help you reflow tagged PDF files and manipulate the structure of tagged documents.

Figure 1-42: The Content palette opens in 
a floating palette alongside the Fields, Tags, 
and Order tabs.

Cross-
Reference
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For information on working with the Content palette and tagged PDF documents, see
Chapter 20.

Fields
The Fields tab enables you to manage form fields on Acrobat PDF forms. You can list all form
fields in the tab and execute menu commands from the pull-down menu and context menu
opened from within the palette.

For information about Acrobat forms, see Part VI.

Tags
Tagged PDF files provide more editing capability with PDF documents, and the files can be
made accessible to adaptive devices such as screen readers. For adding, editing, and annotat-
ing tags in PDF documents use the Tags tab. Together with the Content tab options, you have
much control over document accessibility.

To understand accessibility and the advantages of creating tagged PDF documents, see
Chapter 20.

Info
The Info tab displays the x,y position of the mouse cursor as you move it around the
Document pane. From this tab you can choose to display from among three different units of
measure — inches, points, and millimeters. No changes have been made to the Info palette in
Acrobat viewers.

For information on working with the Info tab, see Chapter 3.

Order
You use the Order tab to manage reading order of documents. This tab also relates to docu-
ment accessibility, like the options available in the Tags tab. The Order tab enables you to
add tags to a document, clear tags, and reorder a page’s contents to change a reading order
that might be read aloud by a screen reader.

For information on working with the Order tab, understanding screen readers, and docu-
ment accessibility, see Chapter 20.

Palette menus
Each of the tabs contains its own pull-down menu. When a tab is open in the Navigation pane
or in a floating window, select the Options down-pointing arrow to open a pull-down menu, as
shown in Figure 1-41. Menu commands found in tabs may or may not be available from the
top-level menu bar. Additionally, some tabs, like the Attachments and Comments tabs, offer
you several pull-down menus.

Cross-
Reference
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Context menus
Context menus can display different options for palette choices depending on where you
open a context menu. If you move the cursor to an empty area when all text and objects in a
palette are deselected and open a context menu, the menu options may be different than
when you select text or an object in a palette. However, this is not always the case because a
few palettes provide you with the same options regardless of whether something is selected
or not. In Figure 1-43 a context menu is opened within the Pages tab. No page is selected in
the palette, and you can see the context menu offers you few options.

Figure 1-43: When all page thumbnails are deselected and a context menu is opened 
from within the Pages palette, only a few menu choices appear in the open menu.

Compare Figure 1-43 with Figure 1-44. In Figure 1-44, a page is selected in the Pages palette.
When the context menu opens, you can see that many more options are available from the
menu list than when all pages are deselected.
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Figure 1-44: When a page is selected in the Pages palette and a context menu is 
opened, more menu choices are available than when no page is selected.

Accessing Help
You can see the number of different commands and tools available in Acrobat are 
extraordinary — and you haven’t yet looked at all the submenu options or different prefer-
ence options accessed from the top-level menu bar. With all these features available to you,
your initial Acrobat sessions can sometimes be overwhelming. Fortunately, the great engi-
neers and program designers at Adobe Systems thought about you and they decided to 
provide some help.

Help with learning more about Acrobat comes in several forms and you can choose from 
several help methods to find the one that works well in your workflow. This section covers
different options for getting help in an Acrobat session.

How To menus
When you launch any Acrobat viewer for the first time, you see a window on the right side of
the Acrobat window. It occupies more than a quarter of the horizontal view, and on smaller
monitors, there won’t be much room to work in the Document pane.
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The window is intended for you to toggle the view on and off as you need help in using
Acrobat on specific limited topics. To hide the menu, click the Hide button at the top of the
How To pane as shown in Figure 1-45. To open the pane when it’s not in view, click the Help
Task button in the Acrobat Toolbar Well or press Shift+F4. If you want the pane to remain hid-
den from view when you launch Acrobat, deselect the check box at the bottom of the pane.

Figure 1-45: When the How To pane is visible it occupies more than a quarter of the 
horizontal width of the Acrobat window. If you do not want the How To pane to open 
when launching Acrobat, deselect the box for Show How To Window at Startup.

When the How To pane is open, several topics are listed as hot links that take you to defini-
tions of the respective items. These items are a condensed version of a more comprehensive
help document explained a little later in this chapter. Keep in mind that not all the Acrobat
features are contained in the How To pane.

Click any blue text or the icons adjacent to the blue text to open a view inside the How To
pane that provides you with a topical listing to assist in refining your search. If you click an
item like Comment & Markup, you can see a contents list for specific items related to help on
working with comments, as shown in Figure 1-46.
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Figure 1-46: Click a category in 
the How To pane, and the 
window information changes to 
reflect information about the topic.

When you see a page icon in the How To window adjacent to a topic, clicking on the icon or
text takes you to help information in the How To window. When you see an icon appearing
as a question mark, clicking on the icon or adjacent text opens the Complete Acrobat Help
document.

When you arrive at the contents list page, as shown in Figure 1-46, click again on any text dis-
played in blue to go to information about the subtopic. Using the example of Comment and
Markup as a category, you could choose to click the Add a note comment link. The window
displays the page containing a description of how to add notes in a PDF file, as shown in
Figure 1-47.

Note
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Figure 1-47: Click an item in the 
contents page and you are linked 
to a page where a description 
appears that explains how to 
perform a task.

In some cases you’ll see a text description informing you how to go about archiving a result
for the item you searched. In other cases you can find dynamic links to the complete Acrobat
Help file. Click a link to open the topic in the Complete Acrobat Help file for a more detailed
description for performing the task.

Docking the window
The How To window is docked on the right side of the Acrobat window by default. You can
move the window to the left side by opening a context menu on the title bar to the left of the
Hide button. When you open a context menu from the title bar, select the Docked Left option.
The How To window moves to the left side of the Acrobat window. When the How To pane is
docked on the left, the Navigation pane and Document pane slide to the right.

The size of the How To window is fixed and you can’t change the horizontal width. Be certain
to deselect the check box for Show How To Window at Startup after you become familiar with
accessing help.
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Navigating the How To window
You can return to the opening view of the How To window, called the Homepage, by clicking
the icon in the top-left corner of the window. The left and right arrows move to the previous
and next window views, respectively. If you navigate through a series of pages and click the
Homepage button, it resets the viewing history and you aren’t able to use the arrow buttons
to retrace your last views. A vertical scrollbar is displayed on the right side of the How To
window when the description is longer than can be viewed on your monitor. If the description
is short, you won’t see a scrollbar.

At the bottom of some descriptions you can find more information related to the topic you
searched. Again with hot links, click the text or an icon to open another page offering you
related information. If you want to return to the contents, click another button, also visible at
the bottom of a description page, indicating you will return to the topics.

If you want to open another topic without being on the Homepage, you can open the pull-down
menu from the Help Task Button. The down-pointing arrow opens a menu with the specific
help topics listed. Selecting a topic reopens the How To pane and a help page associated with
the topic selected from the menu.

Acrobat help
The How To window contains a select group of common Acrobat features about which you
can find help within the listed topics on the Homepage. You can also access more topics by
selecting various topics from the Help Task Button. However, Acrobat is a monster program
with many features and listing all the methods for working in the program is not the intent for
the How To help pane. To browse through a comprehensive help guide you need to access a
different document. The comprehensive help guide contains more than 800 pages covering
just about everything you want to know about Acrobat. There are, in essence, two flavors of
the Acrobat Help guide. You can access the Complete Acrobat 7.0 Help document from the
Homepage in the How To pane or you can open the Acrohelp.pdf file in Acrobat. These two
documents are different in that the Complete Acrobat Help document is a PDF file using a cus-
tom interface. The Acrohelp.pdf file is a standard PDF document contained in the Acrobat
folder. Depending on which one you open, you have some different methods for viewing and
navigation.

Complete Acrobat 7.0 Help
You open the Complete Acrobat 7.0 Help from the Help Task Button. Open the pull-down
menu by clicking the down-pointing arrow and select Complete Acrobat 7.0 Help. When you
open this document without a PDF file open in the Document pane, you’ll immediately notice
you have no access to tools and menu commands. That’s because the document is a PDF file
designed with a special user interface. It appears similar to files you open in Acrobat with a
Navigation pane on the left side of the window and the page contents to the right. It can be
sized and scrolled, but the file is not confined to the Document pane like other PDF files. It
behaves more like a floating window on top of the Acrobat window. When you select the
menu command to open the document, three tabs appear in the top-left side of the window as
shown in Figure 1-48. Click the Contents tab to show bookmarks, Search to search for key-
words, and Index to see an alphabetical list of indexed topics.
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Figure 1-48: The Complete Acrobat 7.0 Help opens as a floating window with three tabs —
Contents, for listing bookmarks; Search, for keyword searches; and Index, for an 
alphabetical topic list.

Contents tab
By default the Complete Acrobat 7.0 Help document opens with the Contents tab exposed as
shown in Figure 1-48. In the Navigation pane you’ll find a table of contents for the document
shown in a very similar manner to the way bookmarks are listed in a PDF document. To
expand the parent item, click the plus symbol (Windows) or right-pointing triangle
(Macintosh). Subtopics appear when you expand a parent topic. To collapse a parent item,
click the minus sign or down-pointing triangle adjacent to the parent item you expanded.
Click one of the parent or child topics listed in the Contents tab to see the respective book-
marked page in the Topic pane.

Search tab
You can use the Search tab to find any word(s) in the help document, as shown in Figure 1-49.
Click the Search tab and the Navigation pane changes to display a field box where you type
your search criteria. Type one or more words in the field box and click Search. The results
then appear in the Search tab. All text appearing in blue is linked to the page that opens in
the Topic pane.
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Figure 1-49: The Search tab enables you to search for
words contained anywhere in the help document. Type the
search criteria in the field box and click Search.

Index tab
The Index tab is similar to any index you find in a manual or book. When you click the tab, a
list of alphabetical characters (A to Z) appears in the Navigation pane. The alpha characters
are parent markers that you can expand like the Contents items. Click the plus sign or trian-
gle to expand the category. Click a child item in the expanded list to open the page link in the
Topic pane.

Navigating topics
The arrows at the top of the Navigation pane enable you to move forward and back to the
pages you view during your search. The review history remains in memory until you close
the document. If you close the help file, the review history is flushed from memory and you
need to begin again to find information on the same topics. On the right side of the Topic
pane is a scroll bar. Use the arrow keys and elevator bar to view documents as you do in any
application document.

Printing topics
The Print tool located at the top of the Navigation pane opens the Print dialog box. In the
Print dialog box you can choose to print a single page, a page range, or the complete help
document. Print controls enable you to fit the page to standard paper sizes, tile pages, and
scale them. These options are handy, as many pages in the help document don’t conform to
standard US Letter size pages.

For information on printing PDF documents and using the Print dialog box, see Chapter 25.

Acrohelp.pdf
When you open the Complete Acrobat 7.0 Help from the How To window you access a file
called ACROHELP.pdf. The file is a PDF document, but when opened using the How To menu
command, the file opens with a custom user interface. This file can also be opened in Acrobat
and viewed with the normal Acrobat user interface. If you want to use navigation tools or per-
form a sophisticated search with Boolean operators, the Complete Acrobat 7.0 Help file needs
to be opened in Acrobat using the Open command. To open the file, click the Open tool or
select File ➪ Open and navigate to the Acrobat 7.0 folder open the Help folder and then open
ENU. Double-click on the file labeled ACROHELP.

You can make comment notes on the Complete Acrobat 7.0 Help document. Select the com-
ment tool you want to use, and then click the Help Tasks Button and open the Complete
Acrobat 7.0 Help document. The last tool you selected in the Acrobat Toolbar Well is active
when you view the help file.

For information on searching PDF files and using Boolean expressions, see Chapter 5.Cross-
Reference
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When you open the Acrohelp.pdf file the file opens like any other PDF. The PDF document
opens with bookmarks visible in the Bookmarks pane in the Navigation pane and these book-
marks contain descriptions identical to the contents in the Complete Acrobat 7.0 Help file.
You also have an index to help you search for topics from an alphabetical list.

In addition, using the tools and viewing the file like any other PDF document, you can search for
information within the PDF file by entering your search criteria in the How To window. Type the
word(s) to be searched for and click the Search button. The search results are reported in the
How To window. Additionally, you can use the new Find tool in Acrobat to search the active
open document. Type your search criteria in the Find tool field box and press the Enter/Return
key on your keyboard to jump to the first occurrence of the searched word.

Many distinctions exist between using the Find toolbar and the Search tool in Acrobat view-
ers. For a complete description of the use of both tools, see Chapter 5.

Advanced search is available to you using Acrobat Search. An index for the file has been cre-
ated for you and is also installed with your Acrobat installation. You need to load the index
before using more advanced search tools and then you can refine your search with many
more search features.

More help
In addition to the help file that covers working in Acrobat, some other help PDF files are
located in the Help folder inside your Acrobat folder. These help documents are specific to
certain tasks, such as pdfmark and Distiller parameters. To view the help documents, open
your Acrobat folder and open the Help\ENU folder. The files are PDF documents and can be
opened in any viewer. 

Online help is available to you as well from Adobe Systems. If you choose Help ➪ Online Support,
your default Web browser launches and the Adobe Acrobat support page opens from Adobe’s
Web site. This Web page and links to the page are continually updated so be certain to make
frequent visits to the Acrobat Online help Web pages.

When accessing Adobe’s Online Support, your Web browser opens in the foreground while
Acrobat Professional remains open in the background. When you finish viewing Web pages
and quit your Web browser, the Acrobat window returns to view.

Additional help links to Web pages at Adobe’s Web site are also contained in the Help menu.
Find support by selecting menu items such as Adobe Expert Support and Online Support.
You can also get help information on document accessibility by selecting the Accessibility
Information Online command.

Understanding Preferences
Preferences enable you to customize your work sessions in Acrobat. You can access a
Preferences dialog box from within any Acrobat viewer and from within a Web browser when
viewing PDFs as inline views. A huge number of preferences exist that all relate to specific
tool groups or task categories, and it would not make as much sense to cover them here in
the opening chapter as it would within chapters related to using tools and methods influ-
enced by preference choices. 

Note

Cross-
Reference
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Some general things you should know about preferences is that they are contained in a dialog
box as shown in Figure 1-50. You make a topic selection in the list on the left side of the dialog
box and the related preferences are shown to the right side of the list. You make choices for
preferences by selecting check boxes or making menu selections from pull-down menus. When
you complete making your preference choices, click OK at the bottom of the dialog box.

Figure 1-50: Press Control/Ô+K to open the Preferences 
dialog box. Click a category on the left and the choices are 
reflected to the left of the categories list.

Almost all the preferences you change in the Preferences dialog box are dynamic, which
means you don’t need to quit Acrobat and relaunch the program for a preference choice to
take effect. Preferences remain in effect until you change them again. If you quit Acrobat and
relaunch the program, the preferences you last made are honored by Acrobat. However, if for
some reason the program crashes and you don’t shut it down properly, any new preference
changes will not be recognized when the program is launched again.

If you find some operation in Acrobat not working as you think it should, first take a look at
the Preferences dialog box. In many cases you’ll find a check box or menu command not
enabled to permit you to perform a task. As you become familiar with specific tool groups
and menu commands, make a habit of routinely visiting the Preferences dialog box so you
understand all the toggles and switches that affect tool and viewing behavior.

07_583786 ch01.qxd  1/31/05  10:28 PM  Page 50



51Chapter 1 ✦ Getting to Know Adobe Acrobat

Summary
This chapter offers you a general introduction for working in both Acrobat Standard and
Acrobat Professional and helps you understand the environment, the user interface, and
some of the many new features added to the commercial Acrobat products. At the very least,
you should know how to go about finding help when you first start working in the program.
Some of the more important points discussed in this chapter include the following:

✦ Adobe Acrobat is a multifaceted program designed to provide solutions for many differ-
ent business professionals. Several types of Acrobat viewers exist, ranging in features
to suit different user needs. The most sophisticated of the three viewers is Acrobat
Professional, now in version 7. Acrobat Standard offers fewer tools and menu com-
mands than Acrobat Professional.

✦ PDF, short for Portable Document Format, was developed by Adobe Systems and was
designed to exchange documents between computers and across computer platforms
while maintaining file integrity.

✦ The PDF language format has changed version numbers along with the Acrobat view-
ers. The current PDF version is 1.6.

✦ Tasks are performed through the use of menus, tools, and palettes that can be
accessed through mouse selections and keyboard shortcuts.

✦ The extensive list of tools appears in an abbreviated form when you open Acrobat and
view the default toolbars. You can open additional toolbars from menu commands. You
can dock toolbars in the Toolbar Well or float them around the Acrobat window.

✦ Palettes are similar to toolbars in that they can be docked and undocked from a well
called the Navigation pane. Palettes contain pull-down menus, and some palettes con-
tain tools.

✦ You can customize the Acrobat workplace to suit your work style through the use of
different preference choices. When preferences, palettes, and toolbars are changed
from their default views, the new views are saved when you quit your Acrobat session.
They remain unchanged until you change them again or reset them to defaults.

✦ Acrobat Professional provides you extensive assistance through the use of help docu-
ments. You can gain immediate help on selected topics through choices in the How To
pane or by expanding your list of categories to seek help in the Complete Acrobat 7.0
Help window.

✦ Preferences are settings that apply globally to Acrobat and influence the behavior of
tools and menu commands.

✦ ✦ ✦
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